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Description  
This document describes release 2.71 of the ROCLINK 800 Configuration Software (W68130), which provides enhanced 
security to the most current products (ROC800 Series 2, ROC800L, DL8000, and FloBoss™ 107). It describes the items 
addressed in this release, details compatibilities, provides upgrade instructions, and includes a revision history.  

Items Addressed  
Security 
 Corrected issue where user cannot save configuration files after opting in to use longer usernames and passwords on the 

ROC800 or ROC800L (SN 173390, SCR RL800_4111) 
General  
 Removed point types 6, 7, 10, 41, 42 when connected to a FloBoss 107 with firmware version 2.00 or newer (SCR 

RL800_4112) 
 Added support for FloBoss 107 firmware version 2.00  

Compatibility  
Item Item Part Number Version 

ROC809/ROC827 Series 1 Boot ROM Image W68127 1.00 
 Flash ROM Image W68126 2.18 
ROC809/ROC827 Series 2 Boot ROM Image W68232 2.00/2.01 
 Flash ROM Image W68233 3.90 
FB107 Boot ROM Image W68181 1.00 
 Flash ROM Image W68182 2.00 
FB107 Measurement Canada Boot ROM Image W68181 1.00 
 Flash ROM Image W68255 1.00 
FB103/FB104 Boot ROM Image W68129 1.10 
 Flash ROM Image W68123 2.15 
ROC306/312/364 FlashPAC Flash ROM Image W68067 2.23 
ROC306 FlashPAC Measurement 
Canada 

Flash ROM Image W68072 2.20 

FB407 Flash ROM Image W68044 1.14 
FB407 Measurement Canada Flash ROM Image W68057 1.08a 
FB503/FB504 Flash ROM Image W68061 2.48 
DL8000 Series 1 Boot ROM Image W68127 1.00 
 Flash ROM Image W68201 1.13 
 User Program Set W68209 1.05 
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Item Item Part Number Version 

DL8000 Series 2 Boot ROM Image W68232 2.01 
 Flash ROM Image W68252 2.53 
 User Program Set W68209 2.35 
ROC800L Boot ROM Image W68232 2.01 
 Flash ROM Image W68258 1.70 
 User Program Set W68272 1.53 
GB601/GB602 GridBoss Flash ROM Image W68081 1.10 
 Flash ROM Image W68082 1.10 

 

Notes: 

 If there is no serial port available, Energy and Transportation Solutions recommends using a USB-to-serial adapter (such 
as the Bafo® Model BF-810). 

 Prior to performing the installation, you must temporarily disable user account control. This ensures that all files copy 
correctly and are not limited by modern Microsoft® Windows® security enhancements. See Disabling User Account 
Control below.  

 If RL800 is installed on a Windows Server 2012 and you experience Ethernet communication problems, you should 
disable the Explicit Congestion Notification (ECN) functionality within Windows. An administrator can accomplish this by 
entering the following command from a command prompt:  

netsh int tcp set global ecncapability=disabled 

Disabling User Account Control  
 
For Windows 10 / Windows Server 2016: 

1. Enter UAC into the search field in the Windows task bar.  

2. Within your search results, click Change User Account Control Settings.  

3. Drag the slide control down to Never Notify and click OK. This turns off UAC.  

4. To re-enable UAC (if desired), repeat steps 1-3 and drag the slide control back up to the desired level of security.  

5. Run setup.exe as administrator from context menu. Right mouse click and select run as administrator. 
 
For Windows 7: 

1. Launch MSCONFIG. Click the START/ORB icon in the lower left-hand corner, type MSCONFIG in the "Search 
programs and files" field and click Enter.  

2. Click on the Tools tab. 

3. Scroll down until you find "Change UAC Settings". Click Launch. 

4. A User Account Control Settings window opens. Move the slider to Never Notify. 

5. Click OK to perform the change. 

6. Click OK to close the System Configuration window. 

7. You need to reboot the computer for changes to apply. 

Note: To re-enable UAC, performing the steps above and select the "Default" slide bar User Account Control setting. 

For Windows Vista: 
1. Launch MSCONFIG. From the Run menu, click the START icon in the lower left-hand corner, type MSCONFIG in the 

Start Search field, and click Enter.  

2. Select the Tools tab. Scroll down until you find Disable UAC. Click on that option. 

3. Click Launch. 
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4. A CMD window opens. When the command is done, close the window.  

5. Close MSCONFIG. You need to reboot the computer for changes to apply.  

Note: To re-enable UAC, select Enable UAC option and click Launch.  

For Windows Server 2012: 
1. Run MSCONFIG (press the Windows key + r and enter msconfig in the Run window).  

2. Go to the Tools Tab. 

3. Launch Change UAC Settings.  

4. Select Never Notify.  

5. Open your Registry Editor (press the Windows key + r and enter regedit.exe in the Run window). 

6. Browse to 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\system  

7. Change the value of the DWORD EnableLUA from 1 to 0. 

8. Windows displays a notification dialog that a reboot is required; after you reboot, UAC is disabled. 

Windows 7 and the ROCLINK 800 Display Editor   
Windows 7 users may experience slow performance in the ROCLINK 800 Display Editor. The workaround is to modify the 
ROCLINK 800 shortcut properties. Right-click and select Properties. On the Compatibility tab and inside the Settings frame, 
select the Disable desktop composition option. Click the OK button and restart ROCLINK 800. 

FB107 USB License and Port 6001  
The FB107 USB license key software requires use of port 6001 to communicate. This is not a configurable parameter and can 
cause server port conflicts with SCADA host applications. It is recommended that you configure SCADA host server port 
designations to use ports outside of this range. 

Install Issue with the FB107 License Key Software  
If the FB107 USB license key software does not install as expected, use the following instructions to install the software: 

1. Go to the web site http://www.safenet-inc.com/support-downloads/sentinel-drivers/. 

2. Download the Sentinel driver file. 

3. Unzip the file. 

4. Run Sentinel System Driver Installer 7.5.8.exe.  

ROC800 Log Tool  
Upgrades of ROCLINK 800 from previous versions continue to use a previously installed version of the ROC800 Log Tool. 
New or uninstalled ROCLINK 800 setups will install version 1.1.0.0 of the tool in addition to the previous version. 

Firmware/Software Update Instructions  
Note: The Update Wizard does not support downgrades. If you require an earlier version of the software, remove the existing 
version, remove the directory, and install the earlier version.  

Important 
If you have an earlier version of ROCLINK 800 installed, you must uninstall the older version of ROCLINK before you 
attempt to install version 2.41 or higher. 

1. Obtain the DVD or .ZIP file containing the installation files.  
If you have the .ZIP file, extract the files to a directory (for example, to c:\temp).  

2. Close all applications.  

If you have an earlier version of ROCLINK 800 installed, uninstall it now.  

http://www.safenet-inc.com/support-downloads/sentinel-drivers/
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3. Start the setup program using either of the following methods:  

 Insert the DVD; if autorun is enabled, the setup program automatically starts.  

 Run setup.exe from the root directory of your CD/DVD ROM drive or from the directory to which you extracted the 
.ZIP files.  

4. Follow the on-screen instructions. You may need to reboot your system, depending on the existing version of some 
operating system files.   

Following the installation, if you receive a DB (database) permissions error after you log onto ROCLINK 800, use the following 
procedure:  

1. Verify that the active Windows user (account) has read/write permissions to the *.mdb files in the ROCLINK 800 
directory.  

2. Close all applications and run the MDAC installation utility located in the \apps directory on the installation DVD.   

Known Limitations and/or Issues  
Firmware updates of large application modules, such as the Coriolis Interface Module, can result in the inability to properly 
access module display data and/or loss of communications with ROCLINK (800Platform-00000570). Use the following 
workaround to restore desired operation. 

1. Close all ROCLINK 800 dialogs and exit ROCLINK 800.  

2. Physically remove the application module from the ROC800 Series device.  

3. Power cycle or warm start the ROC800 device (with the module removed).  

4. While remaining disconnected from ROCLINK 800, reinsert the module.  

5. Wait for a minimum of 15 seconds after the insertion of the module before reconnecting to the ROC800 device with 
ROCLINK 800.  

6. Log onto ROCLINK 800, connect to the ROC800 device, and verify the updated version of module firmware has 
been applied.  

When trying to append EFM data to the auto-selected file in the FloBoss 107, the user may receive an error. If the error 
occurs, the use can manually select the file to append. This workaround allows the user to successfully append to file.   

Change History  
Version 2.70 to 2.71 (9-December-2022) 
Security 
 Corrected issue where user cannot save configuration files after opting in to use longer usernames and passwords on 

the ROC800 or ROC800L (SN 173390, SCR RL800_4111) 

General  
 Removed point types 6, 7, 10, 41, 42 when connected to a FloBoss 107 with firmware version 2.00 or newer (SCR 

RL800_4112) 
 Added support for FloBoss 107 firmware version 2.00  

Version 2.62 to 2.70 (30-September-2022) 
Security 
 Increased the number of unique users in ROCLINK 800 Security from 32 to 64 
General  
 Added support for ROC800L firmware version 1.70  
 Added support for ROC800 firmware version 3.90  
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Version 2.61 to 2.62 (19-August-2021) 
 Added support for ROC800L firmware version 1.66  
 Added support for ROC800 firmware version 3.86  
 Added support for FloBoss 107 firmware version 1.86 
 Added support for DL8000 firmware version 2.53 

Version 2.60 to 2.61 (11-March-2021) 
 Increased the width of the IEC 62591 commission list to allow the display of the device name (RL80000003768) 
 Resolved issue where in a CFX5 file's "configuration" record's field #12 "live input" was not created properly 

(RL80000003996, SN# 133169, 132823, 131994) 
 Resolved issue where a CFX5 file could contain invalid values in the CFX history records for gas composition values. 

(RL80000003995, SN# 133169, 132823, 131994) 
 Updated the version of Sentinel Driver installed during ROCLINK800 upgrades from version 7.5.8 to version 7.6.0 for 

Windows 10 compatibility (RL80000004029) 
 Modified FB107 BLM List display (RL80000004048) 
 Modified TCP Modbus Master Table Header (RL80000004049) 
 Resolved issue where in a CFX5 file the alarm and events date could be six hours off (RL80000004065) 
 Added HART device type IDs for the following: 

o 248 Polymer - Device Type ID: 0x2676A, device Rev 2 
o 3051 SMV PDP - Device Type ID: 0x2675, device rev 1 
o 3051C - Device Type ID: 0x266A, device Rev 2 (RL80000004074) 

 Added support for Rosemount 8732 Flow Transmitter and Appleton 430 (RL80000004075) 
 Resolved issue where WirelessHART - THUM/subdevice Message is hidden (RL80000004077) 

Version 2.57 to 2.60 (July-2020) 
 Added the option to convert a Gas Meter’s EFM file to CFX8 format. Previously, ROCLINK would only convert to CFX5 

Version 2.56 to 2.57 (25-October-2019) 
 Resolved issue where an FB107 with two Enhanced Communications Modules installed would not display the Modbus 

TCP timeout field for the module in slot 2. (SCR RL80000004051) 
 Added display elements to facilitate the FB107 Enhanced Communications Module re-initialization functionality. 

Version 2.55 to 2.56 (20-June-2019)  
 Updated FB107 LCD display configuration to support 48 Basic List Mode parameters (SCR RL80000004039) 
 Resolved issue when attempting to restore a FB107 configuration after firmware upgrade (SCR RL80000004034)  
 Resolved ROC800 configuration download issue when K-factor setting is different (SCR RL80000004008) 

Version 2.54 to 2.55 (15-November-2018)  
 Added WirelessHART device bursting configuration elements (SCR SmtlO00000556) 
 Added WirelessHART device event interface (SCR SmtIO00000676) 
 Added Adapter IDs and Types to the live list. (SCR SmtIO00000757) 
 Implemented Gratuitous ARP fields for FB107 platform. (SupportNet #127873)  

Version 2.53 to 2.54 (06-November-2017)  
 Enabled the IEC 62591 module to recognize Rosemount WPG45 and 705 wireless sensors. (SCR# RL8000004005)  
 Resolved issue where Collect Data would not work on a ROC800 if the number of Daily History Entries was set to zero. 

(SCR# RL8000004002) 
 Modified the FB107 LCD Display tab to avoid warm starts when the user clicks the Update menu option. (SCR# 

RL8000004001) 
 Enhanced BLM Meter Calibration Report importing routines to avoid compatibility errors with previous versions. (SCR# 

RL8000003998) 
 Resolved receiving “Incorrect File Type” error when installing user programs into Slot 1 of a FB107. (SCR# 

RL8000003997) 
 Changed BLM Meter Calibration Report import routine to display dialog if user mistakenly imports from a configuration 

file. (SCR# RL8000003994) 
 Resolved FB107 reconnection issues after restart over Ethernet. (SCR# RL8000003993) 
 Added the ability for legacy devices (FB103, FB104, ROC300-series, FB407, and FB500-series) to generate a BLM 
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Calibration Report. (SCR# RL8000003992) 
 Modified BLM Calibration Report contents to include additional required fields and reorganized report so the layout made 

sense with the new fields. (SCR# RL8000003985) 
 Modified printing of an original format calibration report to eliminate printing an additional blank page. (SCR# 

RL8000003984) 
 Altered error handling routine to display explanatory dialog for instances where a user attempts to assign an IEC 

Network ID greater than the maximum on a FB107. (SCR# RL8000003997) 
 Modified history download routine on a FB107 to correctly transfer the entire history configuration. (SCR# 

RL8000003946) 
 Corrected Error 3001 which was generated when Coriolis Interface Module points were archived in history on a ROC800. 

(SCR# RL8000003939) 

Version 2.52 to 2.53 (20-April-2017)  
 Corrected an issue with the Installer which prevented install on some PCs. (SCR# RL8000003988 & RL8000003990) 

Version 2.51 to 2.52 (28-March-2017)  
 Added BLM 43 CFR 3175 compatible calibration reports. (SCR# RL8000003680) 
 Added ability to import BLM specific data from previous calibration report. (SCR# RL8000003983) 
 Improved checks for an invalid configuration prevention on PID screen. (SCR# RL8000003967) 
 Removed prompt for a reboot on installation as a reboot is no longer necessary. (SCR# RL8000003857) 
 Modified ROC > Information screen on the 800 Platform to include the ability to enable gratuitous ARPing when network 

communications fail. (SCR# RL8000003966) 
 Modified ARP and GARP fields to gray out when disabled. (SCR# RL8000003972) 
 Added tab in the 800 platform’s ROC > Information screen to monitor and configure options relating to MPU Loading 

Diagnostics. (SCR# RL8000003965) 
 Changed Monel 500 to Monel 400 on ROC800 Meter Setup. (SCR# RL8000003962) 
 Modified Liquid CFX file save routine to include a correct file extension if a user chooses a non-default name. (SCR# 

RL8000003953) 
 Added Modbus Conversion Codes 82-85 (which convert String16 data types) to the 800 Platform. (SCR# 

RL8000003949) 
 Added prompt to ensure the user wants to save a ROC800L or DL8000 configuration file when Weights and Measures 

are enabled. (SCR# RL8000003948) 
 Modified 800L configuration download for Analog Input section to properly download all parameters. (SCR# 

RL8000003938) 
 Resolved issue with FB407 MVS Reset to Defaults command which would cause ROCLINK to close. (SCR# 

RL8000003940) 
 Extended maximum timeout allowable on RL800 initial connection to device to 60 seconds. (SCR# RL8000003937) 
 Resolved an opcode error which occurred while downloading an 800 configuration with Linear Meters. (SCR# 

RL8000003933) 
 Resolved issue with building 103/104 configurations offline. (SCR# RL8000003931; SupportNet# NA) 
 Enhanced 103/104 configuration downloads to avoid a history error that could occur. (SCR# RL8000003930) 
 Resolved potential initialization on the FB107 LCD Display configuration screen when using Auto-Scan. (SCR# 

RL8000003927) 
 Modified ROCLINK 800 handling of when a user tries to download firmware through the User Program Administrator to 

avoid a potential runtime error. (SCR# RL8000003920) 
 Changed parameter 177,x,68 to RESERVED on 800/800L. (SCR# RL8000003897) 
 Added ROCLINK 800 Support for Windows 10 and Windows Server 2012. (SCR# RL8000003944 & RL8000003851) 

Version 2.50 to 2.51 (29-September-2015)  
 Eliminated the error when trying to download a FloBoss 107 offline configuration to an active device. (SCR# 

RL8000003919)  

Version 2.41 to 2.50 (01-September-2015)  
 Corrected incorrect baud rate by checking and sending down correct baud rate if it is increased by one. (SCR# 

RL8000003893)  
 Changed the wording of the warning message to correctly present what is changing in each type of sensor. (SCR# 

RL8000003891)  
 Added the ability to be able to add or remove users in FloBoss 107 Measurement Canada. (SCR# RL8000003870)  
 Increased the max time for APM detector switch filter. (SCR# RL8000003882)  
 Reduced confusion on setup of unit by no longer having user names downloaded during a configuration, due to 
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passwords never being saved or downloaded. (SCR# RL8000003767)  
 Eliminated error when print previewing with display as TLP is selected. (SCR# RL8000003690)  
 Created the ability to save history text fields to a configuration. (SCR# RL8000003795)  
 Eliminated error when trying to export documents to other formats. (SCR# RL8000003799)  
 Increased the number of user defined points a user is able to download. (SCR# RL8000003791)  
 Updated the design of the ROCLINK icon. (SCR# RL8000003672)  

Version 2.40 to 2.41 (26-November-2014)  
 Corrected issue with displaying device variable status for WirelessHART analog variables (SCR# RL80000003775). 
 Eliminated error when selecting the print preview function (SCR# RL80000003789). 
 Corrected issue with specifying the target path in the ROCLINK command string (SCR# RL80000003785). 
 Corrected issue with DS800 Development Suite application not being able to find the newest ROCLINK installation 

(SCR# RL80000003784).   

Version 2.30 to 2.40 (28-October-2014)  
 Enhanced. (SCR# RL800000nnnn)  
 Added support for IEC62591 Discrete transmitters. 
 Added support for Active Advertising on IEC62591 networks (SCR# RL80000003683). 
 Added support for device variable status for WirelessHART variables (SCR# RL80000003692 & RL80000003693). 
 Prevented the ability to select of more commissioned devices than the platform can support (SCR# RL80000003753). 
 Limited IEC Network ID entries to values of 36863 or less per WirelessHART specification (SCR# RL80000003752). 
 Added configuration option allowing the user to ignore status of unused variables; preventing IEC module integrity errors 

(SCR# RL80000003745). 
 Added ability to calibrate Rosemount 4088A and 4088B transmitters (SCR# RL80000003743, RL80000003737, & 

RL80000003736).  
 Added fields to display MVS type and configuration change counter (SCR# RL80000003695). 
 Updated pop-up help text with latest changes and enhancements (multiple SCRs). 
 Modified installer to not automatically place ROCLINK icon on the desk top (SCR# RL80000003702). 
 Corrected issue with installation of the FB107 USB Sentinel license driver used (SCR# RL80000003731). 
 Implemented a pop-up warning, indicating potential CPU overload, when user sets ROC800 Modbus polling period to 

less than 1 second (SCR# RL80000003732). 
 Reduced download time of EFM report data when system has multiple user programs installed (SCR# RL80000003676). 
 Eliminated blank page when printing DRTU import-export lists (SCR# RL80000003648). 
 Corrected issue with showing incorrect value on a FB107 display when the Show Current Value option is selected (SCR# 

RL80000003603). 

Version 2.20 to 2.30 (02-December-2013)  
 Added support for ROC800L enhancements including transactional history retrieval, generation and extraction of Flow-

Cal liquid .cfx files, added support for user weighted averaging technique for meter history points and liquid history 
wizard option. 

 Added support for IEC62591 discrete devices and variables (SCR# RL80000003596) 
 Added support for new API 21.1 2011 compliant averaging technique in the FB107 product (SCR# RL80000003163) 
 Added support for AGA3 2012 flow calculation option in the ROC800, ROC800L, and FB107 products. 
 Added support of a configurable timeout for import point data on RTU Network installations for ROC800 and FB107 

products. 
 Restored Modbus configuration after firmware upgrade of ROC800L unit (SCR# RL80000003604) 
 Resolved issue with daylight savings time parameters not getting set to proper default values when the feature is 

enabled on a ROC800 unit (SCR# RL80000003612) 
 Clamped Modbus master poll delay to a minimum of 1 second preventing the possibility of overloading ROC800, 

ROC800L, and DL8000 units (SCR# RL80000003576, RL80000003577, & RL80000003578) 

Version 2.10 to 2.20 (14-May-2013)  
 Enhanced. (SCR# RL800000nnnn)  
 Added support for Distributed RTU Network functionality 
 Added support for new pulse input parameters in the ROC800 APM module (SCR# RL80000003487) 
 Added support for failsafe value and failsafe mode parameters in the ROC800 Thermocouple module (SCR# 

RL80000003489) 
 Added IEC62591 module support for ROC800L, version 1.20 (SCR# RL80000003542) 
 Modified File New configuration capability allow access to all 8 FB107 opcode tables (SCR# RL80000003529) 
 Enhanced History Wizard to add K-factor average when K-factor curve is selected (SCR# RL80000003085) 
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 Enhanced configuration download process to gracefully handle errors and continue download after warnings are 
acknowledged (SCR# RL80000003473) 

 Added functionality to cache point types, parameters, and displays for user C programs installed in user slot 7 (SCR# 
RL80000003479) 

 Added security options for custom User Displays (SCR# RL80000003509) 
 Added support for DL8000 firmware, version 2.30, sampler points (SCR# RL80000003405) 
 Added warning to alert customer outputs may change on download (SCR# RL80000003353)  
 Resolved issue with FB107 download of slot 7 user program to a FB107 that does not support slot 7 (SCR# 

RL80000003398) 
 Resolved issue with meter calibration when HART AI EU is assigned to input. The user is prompted that HART 

calibration through the Meter menu is not allowed. (SCR# RL80000003434) 

Version 2.00 to 2.10 (31-July 2012)  
 Added support for ROC800L firmware version 1.20 
 Added support for DL8000 firmware version 2.30 
 Added support for IEC62591 WirelessHART module in ROC800, FB107, DL8000, and ROC800L units 
 Added support for Daylight Saving Time in FB107, ROC800, ROC800L, and DL8000 units  
 Reduced the character length of the HART tag field from 10 characters to 8 characters (SCR# RL80000003394)  
 Added alarm inhibit frequency to the level B pulse fidelity configuration on APM (SCR# RL80000003321) 
 Added warning to alert customer when rollover value is decreased (SCR# RL80000003352)  
 Added support for 50 Extended History Points in FB107 (SCR# RL80000003384) 
 Added support for 24 PIDs in the ROC800 (SCR# RL80000003393) 
 Added support for additional heating value reference temperatures in the FB107 (SCR# RL80000003390) 
 Corrected DS800 Configuration point parameter abbreviations in ROC800 (SCR# RL80000003382) 
 Resolved issue with ROC800 HART-2 card parameter writes to all logicals (SCR# RL80000003375) 
 Added 8 Pt vs 16 Pt logical compatibility check when downloading configurations to ROC800L (SCR# RL80000003367) 
 Provided additional checkboxes for configuration downloads (SCR# RL80000003329) 

Version 1.90 to 2.00 (09-March-2012)  
 Added many corrections and enhancements to the ROCLINK help text 
 Added temperature bias option for ROC800 MVS modules. (SCR# RL80000003246) 
 The correct displays are downloaded to the ROC 800 when upgrading Coriolis App Module firmware. (SCR# 

RL80000003374) 
 Added temperature bias to MVS modules for ROC800 family. (SCR# RL80000003246) 
 Resolved issue recognizing HART modules installed in DL8000. (SCR# RL80000003350) 
 Added feature to extract all files from flash memory (Utilities > Read File From Device). (SCR# RL80000003322) 
 Increased gas quality resolution in EFM report. (SCR# RL80000003273) 
 Corrected issue viewing EFM report when Fpv is NaN value. (SCR# RL80000003333) 
 Added Remove, OK, and Cancel buttons to the FB407 ROC security configuration screen. (SCR# RL80000003340) 
 Added ability to configure FB107 PIM module input points on a File\New configuration. (SCR# RL80000003177) 
 Added missing AI parameters to roc.mdb for the DL8000. (SCR# RL80000003190) 
 Added No Flow Time value on the FB107 AGA7 EFM report. (SCR# RL80000003283) 
 Resolved issue when opening Modbus Configuration for COMM1 (Ethernet) from File > New configuration file. (SCR# 

RL80000003293 ROC800) 
 Updated database with new parameters. (SCR# RL80000003190 DL8000) 
 Prevented saving of configuration during batch active transaction. (SCR# RL80000003148 DL8000) 
 Added 115200 as a selection for baud rate. (SCR# RL80000003189 DL8000) 
 Made change to no longer allow stopping DS800 kernel when viewing a config file. (SCR# RL80000003193) 
 Added support for setting MVS temperature bias. (SCR# RL80000003216 DL8000) 
 Increased the number of user logon entries from 16 to 32. (SCR# RL80000003218 DL8000) 
 Added support for logoff command. (SCR# RL80000003219 DL8000) 
 Added support for user entered security timeout. (SCR# RL80000003221 DL8000) 
 Added support for HART analog tags. (SCR# RL80000003222 DL8000) 
 Added support for Modbus master over ethernet. (SCR# RL80000003242 ROC800L)  
 Added support for the HART-2 module. (SCR# ROC800L/DL8000) 
 Added support for the new RTD module. (SCR # RL80000003244 ROC800L)  
 Added support for new Thermocouple module. (SCR# RL80000003245 ROC800L/DL8000) 
 Added support for temperature bias to MVS modules. (SCR# RL80000003246 ROC800L) 
 Added support for baud rate of 115200. (SCR# RL80000003247 ROC800L) 
 Added support for user entered security timeout. (SCR# RL80000003248 ROC800L) 
 Added support for logoff command. (SCR# RL80000003249 ROC800L) 
 Increased the number of user logon entries from 16 to 32. (SCR# RL80000003250 ROC800L) 
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 Added support for Smart Application modules. (SCR# RL80000003251 ROC800L) 
 Added support for hart analog tags. (SCR# RL80000003253 ROC800L) 
 Added W&M Log Option. (SCR# RL80000003269 ROC800L) 
 Added ability to collect events for Gas EFM Report dependent on W&M Log Option. (SCR# RL80000003270 ROC800L) 
 Added ability to convert Gas EFM Reports to CFX dependent on W&M Log Option. (SCR# RL80000003287 ROC800L) 
 Added ability to convert Gas EFM Reports to PGAS dependent on W&M Log Option. (SCR# RL80000003288 ROC800L) 
 Resolved Keypad Display error when opening display editor. (SCR# RL80000003289) 

Version 1.89 to 1.90 (19-October-2011)  
 The FST Editor will now compile when Extended HART Point Type 84 parameters are accessed. (SCR# 

RL80000003292) 
 Added a warning dialog when updating a ROC800 to version 3.30 or greater that user-defined points in the range of 239-

254 are reserved for application modules. (SCR# RL80000003129) 
 FB107 LCD firmware updates are now supported. (SCR# ) RL80000003157 
 Added option to allow user to Enable/Disable Soft Point logging for FB107. (SCR# RL80000003158) 
 Added support for FB107 Opcode 17 logout/disconnect. (SCR# ) RL80000003159 
 Added support for FB107 Security Timeout parameter. (SCR# RL80000003160) 
 Resolved FST run-time error when invalid characters are entered. (SCR# RL80000003171) 
 Added support for FB107 LCD ON feature. (SCR# RL80000003172) 
 Resolved viewing LCD information in FB107 offline configuration file. (SCR# RL80000003180) 
 Resolved viewing I/O Monitor for FB103, FB104, FB503 and FB504 device types. (SCR# RL80000003198) 
 Resolved displaying of floating-point values. (SCR# RL80000003200) 
 Resolved run-time error when viewing ROC800 User Program Administrator. (SCR# RL80000003210) 
 Added support for FB107 slot 7 User C programs. (SCR# RL80000003223) 

Version 1.88 to 1.89 (02-August-2011)  
 Enabled users to specify beginning and end collection dates for EFM data. (SCR# RL80000002706)  
 Resolved (for ROC800-series, File > New) the range error that occurred when selecting a HART Module. (SCR# 

RL80000003181) 
 Enabled (for ROC800-Series) download of Type 92 parameters. (SCR# RL80000003154)  
 Increased (for ROC800-Series) the number of logicals of point type 92 (Logon Parameters). (SCR# RL80000003153) 
 Added additional user defined point checkboxes when downloading a configuration file. (SCR# RL80000003151) 
 Enhanced (for the DL8000) EFM Report Conversion so that Weights & Measures (W&M) events now transfer to an 

.AGA/.DET file. (SCR# RL80000003149) 
 Enhanced (for FB107) the creation process for newly created configs to provide four (rather than three) standard LCD 

user lists. (SCR# RL80000003146) 
 Unable to View > History from File when the ActiveView is Nothing. (SCR# RL80000003132) 
 Restricted firmware update of SAM module to same subtype as existing firmware. (SCR# RL80000003128) 
 Enhanced the descriptive name for a default config file name (File > Save). (SCR# RL80000003115) 
 Improved usability of Communications Monitor, increasing the capture size and export ability. (SCR# RL80000003112) 
 Enhanced (for the DL8000) usability aspects during configuration. (SCR# RL80000003108) 
 Improved (for FB107), the selections for Meter Setup units. (SCR# RL80000003107) 
 Improved collection of data for EFM Reports / CFX Conversion accumulated pulse history when flow input is not set to 

pulse. (SCR# RL80000003101) 
 Improved printing functionality for custom user displays. (SCR# RL80000003098)  
 Resolved (for FB107 with firmware version 1.33) the error messages that occurred when downloading offline config file. 

(SCR# RL80000003096) 
 Enhanced the Event Log to show Point Type 0 events. (SCR# RL80000003094) 
 Added (for the ROC800L) Weights and Measures events to the EFM Report PGAS Conversion. (SCR# 

RL80000003090) 
 Added (for the ROC800L) Weights and Measures events to the EFM Report Flo-Cal Conversion to .CFX file. (SCR# 

RL80000003089) 
 Corrected (for FB107 firmware version 1.33) Save Configuration function (File > Save Configuration) to prevent failures. 

(SCR# RL80000003081) 
 Resolved compiler error in FST Editor when encountering an undefined TLP. (SCR# RL80000003079) 
 Enabled (for FB107) the read of the HART Point Type from the config file. (SCR# RL80000003075) 
 Fixed error after adding a module to offline configuration file when also connected to another device. (SCR# 

RL80000003074) 
 Fixed (for ROC300 with FlashPAC and Measurement Canada) the opcode error that occurred when reading the 

FlashPAC. (SCR# RL80000003073) 
 Enhanced (for ROC827 Series 2) the capability to view more than 200 history points. (SCR# RL80000003072) 
 Enhanced the download (File > Download) of comm port parameters. (SCR# RL80000003077) 
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 Added (for ROC800-Series 2) support for the Application Module. (SCR# RL80000003062) 
 Included (for ROC800L) the Weights and Measures log in EFM Report collection. (SCR# RL80000003059) 
 Enhanced EFM reporting daily totals to display a minimum of three places after the decimal point. (SCR# 

RL80000003052) 
 Added method to automatically save configuration files. (SCR# RL80000003051) 
 Corrected (for FB107) the offline config to show correct first history point. (SCR# RL80000003048) 
 Resolved error that occurred when saving a User Display (with an undefined picture object on the canvas) to file. (SCR# 

RL80000003044) 
 Added Softpoint Data description to OpcodeTable CurrentValues tab and to TLP picker box. (SCR# RL80000003041) 
 Corrected data display (for ROC800 Series 1) in APM module’s configuration window. (SCR# RL80000003040) 
 Added (for FB107) description field for each Soft Point parameter. (SCR# RL80000003035) 
 Added (for FB107) Tag, Parameter Description, and Current Value for each Opcode Table TLP. (SCR# 

RL80000003033) 
 Enabled refresh for a corrupt cached user display. (SCR# RL80000002974) 
 Added (for ROC800) alarm codes for flow calculation alarms. (SCR# RL80000002866) 
 Change the Scan Period in a printed configuration from "number of 50 millisecond intervals" to actual number of 

seconds. (SCR# RL80000002029)  

Version 1.87 to 1.88 (03-November-2010)  
 Added support for ROC800L version 1.01. 
 FB407 Industry Canada view history is now supported for version 1.08a. (SCR# RL80000003010).  
 Enhanced EFM reporting totals to display a minimum of three places after the decimal point. (SCR# RL80000002992). 
 FB107 EFM Conversion to Flow-Cal will set "L" in cfx file when "At beginning of period" history time stamp is selected. 

(SCR# RL80000002979). 
 Added support to download ROC800 AI read/write midpoints. (SCR# RL80000002966).  
 Added support for ROC800 Opcode 17 logoff command. (SCR# RL80000002964). 
 Added support for ROC800 user entered security timeout. (SCR# RL80000002963). 
 Added support for ROC800 MVS module temperature bias. (SCR# RL80000002962).  
 Added support for the new ROC800 RTD module. (SCR# RL80000002961).  
 Added support for new ROC800 Thermocouple module. (SCR# RL80000002958).  
 Added support for HART units tag parameter. (SCR# RL80000002953). 
 Added support for off line addition of new IO modules to an existing ROC800 configuration file. (SCR# RL80000002632). 
 Enhanced calibration report to include Station\Meter ID, Meter input range, type of connection, plate size, and time of 

day. (SCR# RL80000002563).  
 FB107 COM buffer data correctly reports in hexadecimal format. (SCR# RL80000002945). 
 Resolved FB107 "Key is not unique in collection" error message opening a saved configuration file. (SCR# 

RL80000002944). 
 .aga/.det conversion shows AGA7 raw pulses and uncorrected volume. (SCR# RL80000002940). 
 Added current value field to the select TLP dialog window. (SCR# RL80000002935).  
 Added support for ROC800 Series 2 115200 baud rate selection. (SCR# RL80000002932).    
 ROC800L now shows AI point types as selectable for Meter Run Inputs. (SCR# RL80000002914). 
 Added ROC800, file new support for new HART and DO Relay cross platform modules. (SCR# RL80000002888). 
 Add support for AI calibration report. (SCR# RL80000002837). 
 Modified the ROC800 HART A/D counts for AO to be read/write rather than just read. (SCR# RL80000002678). 
 Supports totalize and accumulation history archives for flow and energy for .aga/.det conversion. (SCR# 

RL80000002526). 
 AATM user program TLP is now available in meter run input TLP selector. (SCR# RL80000002509). 
 Enhanced History Segment Point tab text to match the History Segment Configuration tag. (SCR# RL80000001965). 
 Modified FST editor to not allow user to write to read-only parameters. (SCR# RL80000000075).  

Version 1.86 to 1.87 (27-May-2010)  
 Added support for ROC800L version 1.00 
 Resolved .aga/.det conversion invalid use of null issue (SCR# RL80000002920). 
 Resolved Flow-Cal AGA7 conversion missing raw volume data when the user has point type 47,x,51 configured to 

totalize the uncorrected pulses for the day. (SCR# RL80000002919). 
 Added a means for the user to view the source (TLP) for any displayed value. (SCR# RL80000002918). 
 ROC800 APM alarm values are now displayed into the alarm log. (SCR# RL80000002916). 
 Resolved problem converting FB407 .efm file to .det file. (SCR# RL80000002887). 
 800 Series Hart Calibration values now can be written without restriction allowing calibration of HART AO points. (SCR# 

RL80000002878). 
 Added support for additional ROC800 platform Soft Point Parameters (SCR# RL80000002876). 
 Added support for ROC800 Joule Thompson configuration parameters (SCR# RL80000002874 & RL80000002844). 
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 Added support for ROC800 Modbus Master over TCP/IP (SCR# RL80000002847). 
 Resolved problem calibrating MVS with RL800 (1.86) on ROC800 running firmware version 2.01 or earlier (SCR# 

RL80000002804).  
 Added support for new alarm codes returned by Opcode 118 (SCR# RL80000002866, RL80000002864, & 

RL80000002862).  
 Resolved virtual DO updated firmware download selection issue (SCR# RL80000002860).  
 Added support for ROC800 platform APM level A pulse checking and alarming (SCR# RL80000002858 & 

RL80000002792). 
 Enhanced ROC800L APM Level A bad pulse alarm descriptions (SCR# RL80000002850).  
 Add support for 6-point DO relay in 800 series 2 devices (SCR# RL80000002848). 
 Added support for ROC800 platform differential and linear meter accumulator double precision parameters with 

configurable rollover (SCR# RL80000002844 & RL0000002875).  
 Added support for ROC800 US, Metric (kpa), Metric (bar) Station units (SCR# RL80000002843). 
 Changed the default alarm log value column width to display scientific notation values (SCR# RL80000002831). 
 Added progress bar for downloading user displays (SCR# RL80000002824). 
 Added support for Advanced Pulse Module check/marker pulse verification (SCR# RL80000002810).   
 Added support for new ROC800 HART-2 module in ROC800 firmware v3.10 (SCR# RL80000002786). 
 Added option for viewing communication buffers in ROC memory for ROC300, FB407, FB500 and FB103 products 

(SCR# RL80000002830). 
 Enhanced the display editor to allow more than eight tabs (SCR# RL80000002257). 
 Added FB107 pseudo PI points to File New default configuration (SCR# RL80000002799). 
 Added support for sampler without meter runs on ROC800. 
 Added support for the FB107 LCD touch screen inactivity timer (SCR# RL80000002775).  
 Added support for FB107 Modbus option to select the Year Format for Events and Alarms. 
 Added variable K factors to the ROC800 EFM report. 
 Enhanced custom display editor chart legend to show IO tag name. 
 Added support for FB407 Measurement Canada version 1.05.  

Versions prior to 2010  
For revisions prior to 2010, refer to the readme associated with that release.  
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